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1 What's in the Box:

One D-Prog Software Programmer Device

One USB plug in power adapter

One USB cable

2 AA, 2,000mAh Re-Chargeable Batteries (installed)
One DB-9 to AVR/ISP cable

One USB Memory Stick with Programmer software

The D-Prog must have 2 AA Alkaline batteries or 2 AA Re-Chargeable
2,000mAnh batteries to operate. If using re-chargeable batteries, the
supplied USB power supply and cable will recharge the batteries
internally if the jumper at JP1 is positioned to the left as show in fig.1

Fig.1

WARNING: JUMPER MUST BE SET TO RIGHT
HAND POSTION IF ALKALINE BATTERIES ARE
USED. CHARGING WITH ALKALINE BATTERIES
WILL CAUSE BATTERY LEAKAGE AND DAMAGE
THE D-PROG AND VOID THE WARRANTY!!
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The D-Prog is a hardware device that is used to update pcb software for
the following fixtures via AVR/IPS function:

» impression 90 range fixtures

impression RZ 120 fixtures

* impression 240/300 XL

» Volkslicht 60 and Volkslicht Zoom
e Impression X4 and X4S fixtures

» Volkslicht Spot

The D-Prog can also update X4, X4S, Volkslicht Spot and future fixtures
via DMX.

This instruction manual will show how to install PCB software to the D-
Prog and how to update fixture PCB'’s via the AVR/ISP function.
Updating software to the fixtures that are capable of DMX update feature
will also be shown.

WHEN USING AVR/ISP METHOD OF UPDATING
FOR PCB'S DO NOT UPLOAD THE WRONG
SOFTWARE TO THE WRONG PCB. THIS WILL
DAMAGE THE PCB
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2 Installing the Programmer Update Software for the D-Prog on a
computer

The current version of the Programmer Update Software is only
compatioble on PC’s with WIN 7 or earlier versions

Copy the contents of the supplied USB Memory stick to a new folder
on the Desktop of a Windows computer

Once transfered open the folder named D-Prog Software as shown in
fig 2.
Fig. 2

» D-Prog Software Stick »

Include in ibrary = Share with = Burn New folder

Organize =

A Open

-
. Marne
i Favorites

B Desktop | D-Prag Software

& Downloads Insructions

+# Dropbox X4 Code

= Recent Places ¥45 Code

+J Timeline Explorer = D-Prog Softwarezip

% iCloud Photos

Bl Desktop
@ Libraries
| Documents
o' Music
= Pictures
B videos ~ ¢ [l b

Open the folder named D-Prog Software and locate the executable
file named CDM v2.08.30 WHQL Certified.exe as shown in fig 3.

Doble click the executable.
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Fig. 3
# Mame Date modified Typt
|| APD.hex 1/16/2014 2:07 PM HEX
|| BL.hex 10/28/2013 4:.07 PM  HEX
® CDM 20830 WHQL Certified.exe 11/22/2013 3:00 PM  App
@ pa.exe 1/16/2014 6:24 PM App

This will start the installation of the “FTDIChip CDM Drivers” These
drivers allow the D-Prog Software to automatically select the
appropriate COMM port for the D-Prog to utilize. The splash screen
shown in fig 4 will be shown.

Fig. 4

FTDIChip CDM Drivers

Click ‘Extract’ to unpack version 2.08.30 of FTDI's Windows
Driver package and launch the installer,

www frdichip.com

Cancel ‘
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Click the “Extract” button to start the installation of the driver package.
A new Splash Screen as shown in fig 5 will appear.

Click the “Next” button to install the drivers. Once the install is
completed, installation verification Splash Screen as shown in fig 6
will appear.

Fig. 5

Welcome to the Device Driver
Installation Wizard!

This wizard helps you install the software drivers that some
computers devices need in order to work.

To continue, click MNexd.
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Fig. 6

Completing the Device Driver
Installation Wizard

The drivers were successfully installed on this computer.

You can now connect your device to this computer, F vour device
came with instructions, please read them first.

Driver Name Status

s FTOI CDOM Driver Packa... Readyto use
%" FTOI COM Driver Packa... Readyto use

GLP ¢ German Light Products
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3 Starting the D-Prog PA Software and Loading Hex F iles.

In the software folder that was created locate the “pa.exe” file as
shown in fig 7 and open it. When the software has executed, you will

see the “Programmer Software” as shown in fig 8.

Fig.7
T MName G Date modified
|| APD.hex 1/16/2014 2:07 PM
| | BL.hex 10/28/2013 4:07 PM
W COM v2.08.30 WHOL Certified.exe 112272003 3:00 PM
& pa.exe 1/16/2014 6:24 PM
Fig.8
Prog. Prog/Resd Trensferdsta Proglpdate Help German/<English> Special Fader-Pult

File name z

Type of file : Intel Standard Format
Processor : AT90S 8515

Size of memory : 8192 Bytes

Fuse set Do

Data in buffer : 0Bytes

Data - info :

Port - info : COM1 115200 Baud
Type of Progr. : 7?77

Status - info

Type S
HEX File
HEX File
Application
Application
= | F s

Locate the “<German>/English” menu item to toggle between
German and English languages. (Not all items will translate to full

English)
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Connect the supplied USB cable to the D-Prog and to an available
USB port on the computer. Turn the D-Prog on by pressing the
On/Off button.

In the “File” Menu select “Test Line” as shown in fig 9. If the
software is properly communicating with the D-Prog, an information
dialogue box will appear as shown in fig 10

Fig.9

File | Qui Prog/Read Transferdats ProgiUpdate Help German/<English> Special Fader-Pult

Type of file 3 Vers.: 5.13

Openfile

Savefile

Choose COM - port ’
Test line

Delete Quick-Prog. list

Exit

File name

Type of file : Intel Standard Format
Processor : AT90S 8515
Size of memory : 8192 Bytes

| Fuse set Do

| Data in buffer : 0 Bytes

‘ Data - info :
Port - info : COM1 115200 Baud
Type of Progr. T ???

Status - info

Fig.10

ick-Prog. Prog/Read Transferdata ProgUpdate Help German/<English> Special Fader-Pult

Information = |

‘_0‘ Programmer ready

File name

: [ ok
Type of file : Intel Standard For)| ik
Processor : AT90S 8515

Size of memory : 8192 Bytes

Fuse set Do

Data in buffer : 0Bytes

Data - info S

Port - info : COM1 115200 Baud

Type of Progr. : D-Prog./Vers.: 11

Status - info : Ready
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The next step is to open a *.hex file in the programmer window.
Click on the “File” menu then “Open File” Look in the directory
where the fixture software hex files are located, on the supplied

memory stick and select the file you want to load onto the D-Prog as
shown in fig 11.

Fig.11

%5 AVR - Prog

- | x |
File Quick-Prog. Prog/Read Transferdata Prog.Update Help German/<English> Special Fader-Pult
| {9 Open existing file = | Vers.: 5.13
Look in: Xds_1_23 « @ Er
e Name : Date modified Type Size
— | BL_MAIN.hex 2/5/2014 1252 PM  HEX File 3KB
RecentPlaces | | o y7oomTrh_BL_V18.HEX 2/5/20141252 PM  HEXFile 38 KB
! | Main_X45 PG V123.HEX 2/5/2014 12,52 PM  HEX File 86 KB
|| PT_Trb_BL_V24 HEX 2(5/201412:52 PM  HEX File 43KB
_I Desktop -‘j_];x4571723‘z|p 2/25/2014 409 PM  WinZip File 51KB
File name : =
Type of file : Intel §  Libraries
I Processor : ATO0| My
Size of memory : 8192 || Computer
Fuse set Do
3
Datainbuffer - 0Bytl @A 3 o o
Data - info : Netwark o =l T P
E ) Files of type: [AFies 09 - [ cancel |
Port - info : COMm o s
Type of Progr. : D-Prq) (L Opeimes read ey
Status - info

NOTE:

Alway check for the latest versions of the software for the
fixtures that are being updated. These files can be

supplied from Technical Support at GLP or by via request
from support@glp.de. The files that are supplied with the

purchase of the D-Prog are the latest available at the time
of shipping.
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The file loaded in this example is the Pan and Tilt .hex file for the
X4S fixture. The Programmer should look like fig 12

Fig.12

File name : C:\Users\C..\X4s\X4s_1_23\PT_Trb_BL_V24.HEX
Type of file : Intel Standard Format

Processor : ATMEGA 164 (File Info)

Size of memory : 16384 Bytes

Fuse set : Ext.: FC /High: D8 /Low: F7

Data in buffer : 15675 Bytes

Data - info * PIT TRB X48 BL <Vers.: 7>

Port - info : USB <--> D2PROG

Type of Progr. : D-Prog./Vers.: 11

Status - info : Ready

Next load the hex file into the D-Prog by selecting “Transfer Data”. A
menu list will appear showing all the slots of the internal memories
on the D-Prog as shown in fig 13. Clicking on “Load file list” will
show any files that are already loaded into the D-Prog. Click on the
“P.. * “ line that you want to upload the file to, and the transfer for the
file will begin as shown in fig 14.

Fig.13

| File Quick-Prog. Prog/Read | Transferdata | Prog.Update Help German/<English> Special Fader-Pult

Load file list Vers.: 513

Pl --> X45_MAIN_BL / Vers: 3
P2 --> X4S CPU / Vers: 120
P.3--> LEDTRB_X45 BL/ Vers: 5
P4 --> P/T_TRB_X4S_BL / Vers: 5
P.i5--> X4AMAIN_BL / Vers:: 3
P26 > IMPR X4 CPU / Vers.: 148
P.7--> LEDTRB_X4_BL / Vers. 5
P8 --> PANTRB_X4_BL / Vers:5 _

File name P+9--> TLTTRB_X4_BL / Vers: 5 Trb_BL_V24 HEX

Type of file P.:10 --> VLS CPU / Vers.: 107

Processor P.11--> VLSpot LEDPSU / Vers: 7

Size of memory P:12--> EETrb/ Vers: 5

Fuse set P13 --> VL_PAN_TRB / Vers: 4

Data in buffer P:14--> VL_TILT_TRB / Vers.: 4
Data - info P.:15--» IMPR-CPU-Z-64 / Vers:: 140
P:16--> AVR/DMX-PR [ Vers: 11

Port - info 1
Type of Progr. : D-Prog./Vers.: 11

Status - info
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Fig.14

File

File name
Type of file

Processor
Size of memory
Fuse set

Data in buffer
Data - info

Port - info
Type of Progr.

Status - info

: ATMEGA 1/
1 16384 Byl
: Ext:FC i
: 15675 By!
* PIT TRB X4S BL <Vers.: 7>

: COM1 115200 Baud
: D-Prog./ Vers.: 11

Quick-Prog. Prog/Read Transferdata Proglpdste Help German/<English> Special Fader-Pult

Transfer data into programmer

I | "oriere data to programmer
: C:\Users\
: Intel Stand)| -

Prog.-Flash ....

\ Cancel |

Continue the above process until you have loaded the entire list of
files that are needed. During the process the D-Prog will show “PG-
ONL” in the display as shown in fig 15.

Fig.15

—G]:P—

GERMAN LIGHT

PRODUCTS

since 994 ——

D-PROG

AVR ISP PROGRAMMER
viaDMX PROGRAMMER
DMX DONGLE

DX RECORDER/PLAYER

MODE ENTER DOWN UP
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4 Uploading .HEX files to Fixtures

Connect the DB9 Serial Connector the D-Prog and turn the D-Prog
on. The display on the D-Prog will be as shown in fig 16.

Fig.16

MODE ENTER DOWN UP

Press “Mode” one time and “Choose File” will be displayed as shown
in fig 17.

MODE ENTER DOWN UP
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Press “Enter” then use the “Up” or “Down” buttons to select the file
that is to be uploaded to the PCB as shown in fig. 18

Fig.18

MODE ENTER DOWN UP

Once the appropriate file has been selected press “Enter” then press
the “Mode” button one time to “Choose File” menu, then use “Up” or
“Down” button to scroll to “Program AVR/ISP” menu as shown is fig
19.

MODE ENTER DOWN UP

GLP ¢ German Light Products (erson1.0) 1D



Connect the DB-9 Programmer connector to the connector on the
PCB that is to be programmed as shown in the example in fig 20. If
the connector is plugged to the PCB incorrectly, the D-Prog will turn
off as a safety feature to prevent any damage to the PCB. Once the
connection is made then press “Enter” to access Program Mode and
start programming the PCB as shown in fig 21.

Fig.20

DONGLE
DMX RECORDER/PLAYER

MODE ENTER DOWN UP

Once the programming has started the “Prog. Counter” will show the
progress of the upload then the D-Prog will verify the upload by
showing “Test” in the display as shown in fig 22.

GLP ¢ German Light Products (ersion1.0) 1.6



(7MODE ENTER DOWN UP '
/.} OFF I

After the verification is completed, the D-Prog will display “OK” as
shown in fig 23.

l
[>MODE ENTER DOWN

DO NOT UPLOAD THE
WRONG SOFTWARE TO
THE WRONG PCB. THIS
WILL DAMAGE THE PCB

GLP ¢ German Light Products wersion10) 17



5 Uploading New Software to Fixtures via DMX port

To update fixtures in a DMX Link using DMX the fixture will need to
be powered up and there can be no more than 20 fixtures in the DMX
Link at a time. They should also be of the same type. Fixtures that
have already been updated via AVR/ISP that have the proper boot
loader software in them can be updated using this method. The
instruction sheets for each particular fixture type will note the latest
version of software that must be installed to allow for this method.

Load the appropriate Main CPU file by selecting “Choose File” then
“Up” or “Down” on the D-Prog as shown in fig 24, then press “Enter”
to load that file.

Fig.24

—glp- DT ROS

PRODUCTS | DMX DONGLE
DMX RECORDER/PLAYER

Mode Enter Down UF

MODE ENTER DOWN UP

GLP ¢ German Light Products ersion10) 1.8



Press “Mode” to return to the “Choose File” menu, then press “Up” or
“Down” until “Program via DMX” menu appears as shown in fig 25,
then press “Enter” The display will show the progress of the update
as shown in fig 26.

Fig.25 & 26

v
PRODUCTS | DMX DONGLE
DMX RECORDER/PLAYER

m via DMX

Mode Enter Down UP Mode Enter Down  UF

MODE ENTER DOWN UP MODE ENTER DOWN UP

The fixtures will pan and tilt to a 0/0 position and the displays will
flash and flicker during the update process. Once completed, the
fixtures will reset. During this reset, the Main CPU PCB will send
update software to the remaining PCB’s in the fixture. The Display
will show “UPDATE” during this process.

If during this process of “UPDATE” the fixture encounters a PCB that
does not have the proper boot loader version software in it, it will
produce an “UP-ERR” and the fixture will have to have the proper
software loaded to all PCB’s via AVR/ISP method.

Once this is finished the fixtures will once again reset and then
finalize to Home position and display the proper menu with the new
software for all PCB’s on the Home Menu Screen.

GLP ¢ German Light Products ersion10) 19
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